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Introduction 

Not so long ago a statistical data analysis of any data set larger than a few points was a time-

consuming and tedious procedure.
1, 2

  This was changed first by the introduction of personal 

computers and then by spreadsheets, which are computer programs that allow the user to enter 

and manipulate numerical data.  Spreadsheets were originally designed for business applications, 

but have become essential tools for data analysis in all of the sciences because of the ease with 

which they can perform complex calculations and graph the results.  Many hand-held calculators 

can perform similar tasks, but spreadsheets have the advantage because they store data in an 

easily edited form and produce higher-quality graphs. 

 

In this exercise you will learn the basics of statistical data analysis and of spreadsheet operations 

using the program Excel.  The data that you will manipulate will be measured values of copper’s 

density obtained by first measuring a copper block’s dimensions and then by water displacement.  

Consult The Laboratory Notebook and Before Coming to Laboratory as you prepare your 

notebook for this exercise.  While performing this exercise, refer to Introduction to Statistics in 

Chemistry, Preparing Graphs, and Guide to Excel2010.  Save your work frequently.   

 

Experimental 

This laboratory has no particular safety hazards associated with it, as long as normal laboratory 

protocols are followed. 

 

IMPORTANT!  You must bring either a laptop or a tablet to the laboratory.  Either have 

Microsoft Excel installed on your device or access Excel through https://view.truman.edu/.  

Screen shots in this experiment are from Excel 2010, but other versions of Excel are similar.  

Other spreadsheet programs are acceptable if they have the same capabilities for formatting, 

calculations, and graphing.  The “help” function in Excel or other online resources are useful if 

you run into problems locating specific features. 

 

Before coming to lab, prepare tables similar to Table 1 and Table 2, shown below, in your 

laboratory notebook and label them.  Leave enough space so that each table has twelve blank 

rows for data (there may be up to twelve groups in your laboratory).  Note how each table 

organizes the data in a format that is easy to read and understood. 

 

Table 1.  Partial table used to record the dimensions of the copper blocks and each block’s mass 

in the laboratory notebook.  Your table may have to accommodate data for twelve blocks. 

 

Block 

Number 

Length 

(cm) 

Width 

(cm) 

Height 

(cm) 

Mass 

(g) 

Volume 

(cm
3
) 

Uncertainty in the 

Volume (cm
3
) 

       

       

http://chemlab.truman.edu/the-laboratory-notebook/
http://chemlab.truman.edu/before-laboratory/
http://chemlab.truman.edu/data-analysis/introduction-to-statistics-in-chemistry/
http://chemlab.truman.edu/data-analysis/introduction-to-statistics-in-chemistry/
http://chemlab.truman.edu/data-analysis/preparing-graphs/
http://vpultz.sites.truman.edu/files/2012/01/Guide_to_Excel2010.pdf
https://view.truman.edu/
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Table 2.  Partial table for recording the class data for copper’s density as determined by water 

displacement.  The table in your notebook should accommodate data for as many as 12 blocks. 

 

Block 

Number 

Mass 

(g) 

Volume H2O 

Displaced (mL) 

Density 

(g/cm
3
) 

Uncertainty in the 

Density (g/cm
3
) 

     

     

 

You will be assigned a copper block; write down the number of your block in your notebook, 

and make all of your measurements on the same block.  Describe the block’s color, texture and 

appearance in your notebook’s Results section being as descriptive as possible. 

 

Determination of Density using a Ruler to Measure the Volume 

Obtain the mass of the block to three decimal places using one of the top-loading balances 

located in the laboratory.  It is never good lab practice of set a chemical directly on a balance 

pan.  Therefore, place a piece of weighing paper or a plastic weigh boat on the pan.  Zero the 

balance by pressing the tare button and then place the copper block on the weighing paper or in 

the weigh boat.  Record the block’s mass in Table 1 and in Table 2, making sure that all three 

decimal places are recorded, even if some, or all, of them are 0.  If a balance is not displaying 

three decimal places, or if the number of decimal places changes when you put your block on the 

balance, bring it to the attention of your instructor and he or she will assist you.  We will assume 

that the uncertainty associated with the mass measurement, Δm, is ±1 in the last decimal place 

measured (i.e., Δm = ±0.001 g for balances reading three decimal places). 

 

Measure the length, width and height of your block using a plastic ruler.  The rulers are marked 

off every 0.1 cm, but you can estimate and report the measurements to ±0.01 cm (see Fig. 1).  

We will assume that the copper pieces are perfect rectangular blocks (the four lengths are the 

same, as are the four widths and the four heights, and all sides meet at 90º angles). 

 

 
 

Figure 1.  How to estimate the length of an object to the nearest 0.01 cm with a ruler that is 

graduated in increments of 0.1 cm by dividing the distance between the gradations with ten 

imaginary lines (shown in red).  The length of this object is 1.21 or 1.22 cm. 
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Determination of Density by Water Displacement 

Add enough water to a 50-mL graduated cylinder so that your copper block will be completely 

submerged.  The 50-mL graduated cylinder is marked in 1-mL increments, but you should be 

able to estimate the volume to the nearest 0.1 mL, as shown in Fig. 2.  Record the starting 

volume of water in your notebook.  Carefully place the copper block into the graduated cylinder 

so that you do not break the graduated cylinder or splash out any water.  Gently tap the cylinder 

to dislodge any air bubbles that are clinging to the copper, and record the new volume.  Calculate 

the difference between the final and initial volumes to determine the volume of water displaced; 

enter this value in Table 2. 

 

 
 

Figure 2.  How to estimate the volume to the nearest 0.1 mL in a graduated cylinder that is 

marked with 1 mL gradations by dividing the distances between gradations into imaginary lines 

(shown in red).  The volume in the case shown would be 18.6 mL although others might estimate 

it as 18.5 or 18.7 mL. 

 

Results and Analysis 

Graphical Determination of Density using a Ruler to Measure the Volume 

Open Excel and set up the first worksheet as shown in Fig. 3.
3
  In the cell where it says Date, 

enter the date when the experiment is done.  In the cell where is says Names, enter your name 

and your lab partner’s.  Enter the class data for the copper blocks in columns A through E 

starting with the lowest numbered block in row 4.  Record the block numbers in ascending 

numerical order.  Only enter numbers in these cells; units are in column headings.  You will use 

a subset of the approximately 30 blocks available. 

 

Be sure that all significant figures are shown!  Spreadsheets drop trailing zeros, even if they are 

significant.  Since all of the length, width, and height measurements were measured to the 

nearest 0.01 cm, it may be quickest to select the block of these measurements (cells B4 through 

D15, assuming that 12 blocks are used) and click on the increase decimal places button (  in 

the Number group) to display two digits after the decimal in all of these cells.   Adjust all mass 

measurements to three digits after the decimal. 

 

Enter a formula in cell F4 to calculate the volume of the block from its dimensions.
4
  Copy this 

cell and paste it into cells F5 through F15, or stop earlier if your class has less blocks. 
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Figure 3. Worksheet for the data from the determination of copper’s density from the block’s 

dimensions and its mass. 

 

Determine the uncertainty in the volume, ΔV, from the uncertainties in each dimension (Δx, Δy, 

Δz) using Equation 1 (Eqn. 1).  Since the dimension measurements were estimated to the nearest 

0.01 cm, Δx, Δy, and Δz are all 0.01 cm.  Write the equation and values used in your lab notebook. 

 

 ∆𝑉 = ±𝑉√(
∆𝑥

𝑥
)
2

+ (
∆𝑦

𝑦
)
2

+ (
∆𝑧

𝑧
)
2

 (1) 

 

Translate Eqn. 1 into Excel format and enter it in cell G4.
5
  Copy and paste cell G4 into cells G5 

through G15.  The uncertainty in the volume has one significant figure since even that one digit 

is, by definition, uncertain.  Select volume and ΔV pairs and format to display appropriate 

significant figures.  How does this approach compare with the simple rules for significant 

figures? 

 

In cell H4 enter a formula to calculate ΔV/V (the uncertainty in the volume measurement divided 

by the volume).  Copy and paste cell H4 into cells H5 through H15.  Set the number of 

significant figures in cells H4 through H15 to two by adjusting the number of digits after the 

decimal.  (Two is not the correct number of significant figures, but it will be useful later on.) 

 

In cell I4 enter a formula to calculate the density, d, of the first block.  In cell J4 calculate the 

uncertainty associated with this single measurement of the density, Δd, using Eqn. 2 and cell 

references to values already calculated and assuming that Δm is ±0.001 g.  Select both cells I4 

and J4, then copy and paste into cells I5 through J15.  Select density and Δd pairs and format to 

display appropriate significant figures.  Record the calculations for your block in your laboratory 

notebook. 
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 ∆𝑑 = ±𝑑√(
∆𝑉

𝑉
)
2

+ (
∆𝑚

𝑚
)
2

 (2) 

 

Prepare a graph of the copper blocks’ volume as a function of their mass in Excel.  We need to 

find the relationship between the block’s mass (m) and its volume (V).  We assume that there is a 

linear relationship, which we can write as Eqn. 3, where a is the slope of the line and b is the y-

intercept.  To avoid confusion, the slope is given the symbol “a”, instead of the usual “m”, 

 

 𝑉 = 𝑎 ∙ 𝑚 + 𝑏 (3) 

 

because the mass already has that symbol.  Prepare a graph with volume as the dependent 

variable and mass as the independent variable.
6
  Insert a trend line in the graph and check the 

options to display the equation and R-squared value.  Visually inspect the graph to see if there 

are obvious errors.  All data points should lie close to a straight line.  If everyone in the 

laboratory shows one block far from fitting a linear line, the group reporting data for that block 

must check their reported measurements and report their revised values.  One of the wonderful 

aspects of Excel is that after you correct the values in your worksheet, the graph is automatically 

corrected also.  Compare your values for the slope, intercept, and R-squared with others in the 

class.  Everyone should have the same values if you entered the class data correctly into Excel. 

 

Print two copies of the graph which fill at least half a sheet of paper.  Attach one copy to an 

original page of your notebook and its mate to the corresponding duplicate page.
7
  Ask your 

instructor whether to print a full-page graph directly from Excel or to copy the graph and paste it 

into Word before printing.  Go to the Ruler Data sheet.  Click the Page Layout tab; under 

Gridlines, make sure boxes for View and Print are both checked.  Click Orientation and choose 

Landscape.  Print two copies of the ruler data and attach in lab notebook. 

 

Using Excel’s regression package (see Guide to Excel 2010), calculate the slope, the intercept 

and the uncertainty in the slope and intercept at the 95% confidence limit for these data.  Be sure 

that the slope and intercept found using the regression package are the same as those determined 

from the trend line.  If they are not exactly the same, there is a problem somewhere that you must 

correct before continuing.  Adjust the width of the columns on the regression-output worksheets 

so that all of the headings can be read.  (Try AutoFit Column Width under Format in Cells group 

on the Home tab.) 

 

On the Page Layout tab, set the Orientation to Landscape and make sure that the table fits onto 

one sheet of paper by using Print and viewing the preview.  Never split tables over two sheets 

unless absolutely unavoidable.  Print out two copies so that you can attach one copy to an 

original and one to a duplicate page in your notebook.  Save the Excel file and record the name 

you saved it under in your laboratory notebook. 

 

Write down in your notebook the final values of the slope and intercept, and give their 95% 

confidence interval.  Watch your significant figures and units!  Remember that the uncertainty is 

telling you the position of the last significant figure.  

http://vpultz.sites.truman.edu/files/2012/01/Guide_to_Excel2010.pdf
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Determine copper’s average density, d, from the slope of the best-fit line on your Excel graph.  

(Do the calculation in the regression output sheet using a cell reference to the slope and copy into 

your lab notebook.)  Calculate the uncertainty in copper’s density at the 95% confidence limit.  

First find Δd from the standard deviation in the slope of your Excel graph (Δa, labeled “Standard 

Error” in the output for the regression package) using Eqn. 4.  This must be done because the 

slope is 1/d, and so Δa is not Δd.  

 ∆𝑑 = ±𝑑√(
∆𝑎

𝑎
)
2

 (4) 

 

When dealing with two-dimensional data sets, we must use a slightly different approach to 

calculate the confidence interval, as compared to one-dimensional data.  In the two-dimensional 

case, the confidence limit is calculated as  = t·, where  is the standard deviation and t is 

determined based on n – 2 degrees of freedom, where n is the number of x, y pairs in the dataset.  

Since we want uncertainty in the density,  corresponds to Δd.  (Notice the absence of the square 

root of n term, this is not a typo!)  Use the TINV function in Excel to find the appropriate value 

for Student’s t.  Perform all calculations in Excel and record in your lab notebook. 

Calculate a percent error for the average value using the accepted density of copper (8.96 g/cm
3
).

8
 

 

Determination of Density by Water Displacement 

Prepare the second worksheet in your Excel file for the water displacement data so that it looks 

like that shown in Fig. 4.
9
  Enter the class data.  Ideally you could go to Sheet1 (which you 

should rename as “Ruler Data”) and select all block numbers in column A, then copy and paste 

into Sheet2 (renamed as “Water Displacement”) starting with cell A5.  Also copy and paste the 

masses from the worksheet with the ruler data.  Enter the reported values for the volume of water 

displaced which will be different from the volumes calculated based on ruler measurements.  

Check the format of the masses to verify that they still represent measurements made on a 

balance which reads to the nearest 0.001 g.  Since the volumes of water displaced will be read to 

the nearest 0.1 mL, format the volumes to reflect this precision.  (If a group has a small copper 

block, they may have chosen to use a 10-mL graduated cylinder with a smaller uncertainty in 

their volume measurements.)  Calculate the density of each block from its mass and volume by 

entering the correct formula in cells D5 through D16.  In cell G5 enter a formula to calculate the 

uncertainty in the density for this particular block using Eqn. 2 and remember that for most 

blocks ΔV will be 0.1 mL.  Copy and paste for the rest of the blocks, adjusting the value used for 

ΔV if a 10-mL graduated cylinder was used.  Note that the densities and their uncertainties for 

individual blocks usually differ from what you calculated based on ruler measurements.  Since 

the uncertainty has one significant figure, format the density and uncertainty in the density so 

that each pair for a particular block has the same number of digits after the decimal.  
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Figure 4. Worksheet for the data from the determination of copper’s density by water displacement. 

 

In cell D17, calculate the average density using the AVERAGE function.  Adjust the number of 

significant figures in the calculated average (remember that the average can be no more precise 

than the least precise number used to calculate it). 

 

Inspect the data to identify whether any point seems to be out of place.  If you find a point that 

you think is an outlier, first check that there were no computational or other gross errors, then 

perform the Q-test (Introduction to Statistics in Chemistry, Eqn. 6 and Table 2) on the suspect 

point.  The easiest way to perform the Q-test is to select cells A5:G16, click on the Data tab, then Sort, 

and choose Sort by Column D.  Calculate Q for the lowest and highest densities.  Record these 

calculations in your notebook.  If you can eliminate a point, ask your instructor whether you should 

format it in Strikethrough or remove it completely from the spreadsheet.  Write in your notebook beside 

Table 2 that this point was “eliminated on the basis of a Q-test.” 

 

Calculate the estimated standard deviation, S, of the data using Eqn. 5, where N is the number of 

points in the data set, xi is each individual measurement and xavg is the average.  First, we will do 

it in a step-wise calculation, and then use a built-in Excel function. 

 

 𝑆 = √
1

𝑁 − 1
∑(𝑥𝑖 − 𝑥𝑎𝑣𝑔)

2
𝑁

𝑖=1

 (5) 

 

In cell E5 enter a formula to calculate (xi – xavg) using an absolute reference to the cell which 

contains the average.
10

  This will stop Excel from automatically changing the reference to the 

http://chemlab.truman.edu/data-analysis/introduction-to-statistics-in-chemistry/
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cell with the average when we copy and paste cell E5 into cells E6 through E16.  Look at the 

equations in the cells after you paste them in to convince yourself that what you expect to happen 

is actually happening.  Adjust the significant figures as needed. 

 

Enter a formula in cell F5 to calculate (xi – xavg)
2
, and then copy and paste it into the appropriate 

cells in column F.
11

  Be sure that each cell displays the correct number of significant figures. 

 

In cell D18 enter a formula to calculate Σ(xi – xavg)
2
 using the SUM function and in cell E18 enter 

the units for the numerical value in cell D18.  If you removed a data point based on the Q-test, do 

not include it in the range for the SUM function. 

 

In cell D19 enter a formula to calculate S from cell D18 using the SQRT function to implement 

Eqn. 5. Treat the square root as you would treat division to determine the number of significant 

figures. The number of data points, N, is an exact number, and as such does not affect the 

number of significant figures in the standard deviation.  Note that, as with the average, the 

standard deviation cannot be more precise than the original data!  Enter the units of S in cell E19. 

In cell D20 use the STDEV function to calculate S directly from the data in cells D5 through 

D16.  Enter the units for cell D20 in cell E20.  Note that from now on, if you need to calculate 

any statistical quantity (i.e., average or standard deviation) you can use the spreadsheet’s built-in 

functions, instead of the elaborate procedure that you used in this lab. 

 

Enter an equation in cell D21 to calculate the uncertainty at the 95% confidence level from the 

estimated standard deviation in cell D21.  The expression that you will need is Eqn. 5 at 

Introduction to Statistics in Chemistry.  Use the TINV function to find the appropriate value of 

Student’s t.  In cell E21, enter the units of Δ. 

 

Print out two copies of this worksheet (Landscape orientation with gridlines printed) and attach one 

copy to a page and the other copy to the duplicate page in your notebook.  Calculate the percent error in 

copper’s density as measured by this method.  Save the Excel file again. 

 

Conclusions 
As discussed at http://chemlab.truman.edu/the-laboratory-notebook/, there are three types of exercises 

that are encountered in chemistry.  This exercise’s focus was on measurement, so use the Outline for 

Measurement Experiments.  You have data on copper’s density obtained from two different methods, and 

each will need to be discussed.  But, you do not need to have two separate discussions of the two 

methods; they can be discussed simultaneously.  

 

As part of your conclusions include a discussion of whether the assumptions made in each method were 

likely to be valid, and how the results would be different if the assumptions were not valid.  This 

discussion can be qualitative (i.e., no calculations required), but it must address all of the assumptions. 

 

When you determined the density by measuring the copper block’s volume using the ruler you calculated 

ΔV/V, the ratio of the error in the volume to the total volume.  Include in your discussion what you notice 

about ΔV/V for the small blocks as compared to the large blocks.  What does this mean and why might 

this be a problem? How would you modify the experiment to minimize its effect on the density? 

 

 

Summary of Results 
The table that summarizes your results should look like Table 3; substitute your values for those shown. 

http://chemlab.truman.edu/data-analysis/introduction-to-statistics-in-chemistry/
http://chemlab.truman.edu/the-laboratory-notebook/
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Table 3.  Summary of class results for the determination of copper’s density by two different methods.  

All confidence intervals are at the 95% confidence limit. 

 

 From Volume 

Determined by Ruler 

Determined by 

Water Displacement 

Density 8.94 ± 0.05 g/cm
3
 9.0 ± 0.1 g/cm

3
 

Number of Points 12 11 
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